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Preface

Thank you for placing your trust in this devolo product.

With the dsI* 1100 WLAN, you have chosen a DSL modem router that unites the
functions and advantages of an ADSL2+ DSL modem and an IEEE 802.11g
WLAN router in a single device—including a preconfigured SPI firewall to pro-
tect you against attacks from the Internet. In designing the dsI™ 1100 WLAN, we
have placed great value on easy, reliable setup. After just a few configuration
steps, the dsi* 1100 WLAN will serve you as an optimized, user-friendly net-
working and Internet access solution for home and small-office/home-office
(SOHO) use. The included WLAN USB stick with automatic self-installation under
Windows also guarantees optimal WLAN functionality.

Thanks to its integrated ADSL2+-standard modem, you will be ready for future
DSL connection speeds of up to 25 Mbps.

About this manual

Exacting manufacturing standards and stringent quality control are the basis for
high product standards and consistent quality to ensure your fullest satisfaction
with your dsI* 1100 WLAN.

This documentation was compiled by several members of our staff from a variety
of departments in order to ensure you the best possible support when using your
product.

For further information, please visit www.devolo.com

Our devolo website www.devolo.com is available to you around the clock should
you have any queries or require any further support.
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Package contents

Please ensure that the delivery is complete before beginning with the installation
of your router:

® dsl* 1100 WLAN

WLAN USB stick

Mains power adapter for connection to a power supply

DSL cable for the connection of the dsI* 1100 WLAN with the DSL connector

Network cable for the connection of the dsI* 1100 WLAN with a computer,
dLAN adapter, IP telephone or another network device

Printed installation flyer

@ dsl* 1100 WLAN CD with

O Installation wizard

O Product manual

O Network manual (German)
O Software

devolo AG reserves the right to change the package contents without prior
notice.

Description of the symbols
Here we briefly describe the meaning of the symbols used in this manual.

Very important notice which, if ignored, may lead to damage.

Important notice which should be heeded.

Addlitional information which is useful to know, but not vital.

T:K)Bb

(| devolo dsl+ 1100 WLAN |




Contents
T INErOdUCHION couveccirirr e .7
T1 0 WARATIS ADSL? 1o+ e 7
1.2 WAL IS WLAN? Lo+ e e e e e 7
1.3 What does the dsI* 1100 WLAN have t0 offer?.........cccoocoovcvmciom oo oo 9
T4 VITUS SCANMNET oottt e e e e e e .1
2 Connection and installation ... —— .12
2.1 Display and CONNECHIONS ..o.oueiiicieeiee e+ e e e e 12
2.2 Connecting the dsI™ 1100 WLAN ..o e e e e e 13
221 NI USE oo e .14
2.3 Networking @XamMPIES ......o.iuiiriiicirieiieee s+ e e .16
3 Router configuration ........cocoveececnenesenneeseseses s e A7
3.1 Setting up the WLAN and Internet access with the configuration wizard ......... 17
3.2 Setting up Internet acCess Via @ BrOWSET ........c.oviieioiiiieiiicies e e e e .18
321 OVEIVIEW o+ e e .18
3.2.2  CONNECION STALUS ..ovoeiieeiie e+ e e e e .19
3.2.3  WLAN STALIONS ovviiiiieiii e+ e e . 20
3.3 EXPert CONFIGUIALION w.oviiiiiiiiiic e+ e e e . 20
3.3.1  Change confiQUration .......o.eueveiveieiuiieieeeeeeeses e e .21
332 Save configuration file .......ocooiviiiiiieie .27
3.3.3  Restore configuration file ........cccooiviiriioiiiiee e .27
334 Update firmWare .....oocoviiiieiisiceeee s e e .27
4 devolo SOFIWAIE ... e e e .29
4.1 Overview of the devolo SOFIWATE ..o e .29
411 devolo INFOrMET ... e e e .29
4.1.2  devolo Extended Port Forwarding ..........cccocoeveovnvvicio e oo oo 29
4.1.3  devolo EaSySNare ..o e .29
4.1.4  devolo EaSyClean ..o e .29
4.2 Installing the devolo SOTtWAre .........cccovieiiieiiieee e e e .29
4.3 Overview in the network with the devolo Informer ..o o000 L 30
4.4 Port forwarding with devolo Extended Port Forwarding .........cccocoee oo oo o v o2 31
4.5  Communication in the network using devolo EasyShare ..o . oot 32
451 CONFIGUIALION ©.oiviiiicc e e .32
4.6 Maintain your privacy with devolo EasyClean ..o oo oo L. 34

| devolo dsl+ 1100 WLAN | )




5 APPENIX ot ———— s e .36
5.1 Performance data and specifications ..........cccooveiininniininiiiee e .36
5.2 Declaration of CONOMMItY ©..oo.oviiiiiciiei e e .38
5.3 CECONfOMMILY coovoieiic s e e .39
5.4 Care and maintenance of the deviCe ... e .39
5.5 Warranty CoNditiONS .....c.ovoveeeiuriieiieeeeiee et e .40

(| devolo dsi+ 1100 WLAN |




[ntroduction JIVAD

1.1

1.2

WLAN client

Introduction

What is ADSL?

The sheer speed of development of computer technology over the last few years
has resulted in a huge increase in the volume of electronic data traffic. More
users want to send and receive a constantly increasing volume of data. A
demand which offers fertile grounds for the development of broadband technol-
0gy.

ADSL (Asymmetric Digital Subscriber Line) and the advanced ADSL2+ is a trans-
mission technology which offers genuine broadband communication to the user.
The “last mile” connects the customer to the network via copper telephone lines.
Because telephone lines are used to transmit data, the spread of this access
technology has been relatively fast.

Together with the ADSL technology on the copper twin wire of the telephone
lines, three differently large frequency ranges are used: Two for data communi-
cations and one for telephony. The term 'Asymmetric' indicates that the trans-
mitting and receiving channels can carry different quantities of data:

@ When the user surfs the Internet, the data sent to the Internet service pro-
vider (ISP) tends to carry less information (e. g. addresses of web sites or e-
mails). The transmission rate of up to 1 Mbps is generally sufficient for this
purpose.

@ Toload multimedia content (video sequences, animations, images etc.) onto
the computer from the Internet at acceptable quality and speed, a transmis-
sion rate of up to 25 Mbps brings significant savings in terms of cost and
time.

What is WLAN?

Wireless Local Area Network is a radio technology commonly used in home
networking.

Unlike conventional local area networks (LANs), WLANs do not need cables to
connect the individual devices on the network. WLAN clients and WLAN access
paints are required for wireless connections.

® WILAN clients are network adapters, such as wireless network cards or
WLAN USB sticks, used to integrate desktop or notebook computers into a
wireless network.

| devolo dsl+ 1100 WLAN |)




(BEM ntroduction |

WIAN accesspoint - @ WLAN access points are base stations that act as bridges between a LAN
and a WLAN, managing the data communications between the two net-
works. The access point integrated in the dsI* 1100 WLAN complies with the
IEEE 802.11b/g standard, making it compatible with all common wireless
network adapters. In addition, its g++ turbo mode lets the dsI* 1100 WLAN
achieve a bandwidth of up to 125 Mbps within the WLAN.

The maximum area in which wireless network cards, WLAN USB sticks and
WLAN access points can communicate with one another is called a radio cell.

Data security

The dsI* 1100 WLAN supports WEP (Wired Equivalent Privacy), WPA (Wi-Fi
Protection Access) and WPA2 (Wi-Fi Protection Access 2) encryption.

@ WEP stands for a protocol that encrypts the wireless signal with a 64-bit or
128-bit key to ensure secure data communication within the WLAN.

@® WPA is a more recent standard that uses TKIP (Temporal Key Integrity Pro-
tocol). This protocol replaces the static WEP codes with dynamic keys. Using
longer keys and changing them more frequently increases the security of the
network.

@® WPA?2 is the successor of WPA which supports AES (Advanced Encryption
Standard). WPA2 and WPA can be deployed jointly, provided the access
point and the client support WPA2.
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1.3

What does the dsl™ 1100 WLAN have to offer?

The dsI* 1100 WLAN is a DSL modem router designed to provide easy Internet
access. One or more computers can access your DSL line via the various connec-
tion options of the dsI* 1100 WLAN. Every connected computer can thus access
the Internet through the dsI* 1100 WLAN. With its WLAN antenna, the dsl*
1100 WLAN supports both wired and wireless home networks. The so-called
WECT function (WLAN Easy Config Touch) of the dsI* 1100 WLAN automati-
cally configures WPA2-encrypted connections between the dsI* 1100 WLAN
and computers using the included WLAN USB stick and running Windows 2000
or Windows XP.

Quickly and simply online!

® Connect the dsI* 1100 WLAN to the mains power via the supplied mains
power adapter

@ Turn the dsI™ 1100 WLAN on and move the WLAN antenna into an upright
position

® Connect the dsI™ 1100 WLAN with the supplied DSL cable to the existing
DSL connection.

@ Plug the included WLAN USB stick into a USB port of your desktop or
notebook computer or connect the dsi* 1100 WLAN with the enclosed
network cable to the computer.

@ Configuring the WLAN and Internet access:

O For Windows users: Insert the CD, configure the WLAN and Internet
access with the help of the configuration wizard.

O For Mac and Linux users: Configure Internet access with the help of the
setup wizard in the web browser.

@ Ready!

Faster in the Internet!

With the dsI™ 1100 WLAN, you can surf the Internet and transfer files at speeds
of up to 25 Mbps, making it ideal for applications such as IPTV, high-definition
video streams (HDTV, Video-on-Demand), Internet telephony (VolP) and online
gaming. Long delays are thing of the past.
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Surf together!

Share your DSL line and have fun together. With its integrated LAN switch, the
dsI* 1100 WLAN provides wired Internet access for up to 4 computers at the
same time, plus additional computers via the WLAN.

Simultaneous surfing and telephoning via the Internet!

Using the dsI* 1100 WLAN you can employ Voice-over-1P (VolP) for your phone
calls. In order to ensure good speech quality even when you are surfing the
Internet, the packets necessary for speech transmission are given priority by the
dsI* 1100 WLAN. Please note that for the use of Internet telephony, registration
with an Internet telephone service provider as well as additional PC software
(Softphone) or hardware (IP telephone, VolP adapter) are necessary.

Meets the highest quality standards!

The products from devolo are subjected to thorough German quality assurance.
In this way, devolo assures the optimal functionality with operating systems,
international versions and protocols.

Safety first!

The integrated SPI firewall and its powerful filters provide optimal access control
to ensure the security of your computers. What's more, antivirus software (“Virus
scanner”) is included in the package.

The data security of your WLAN is guaranteed by WEP (Wired Equivalent Pri-
vacy), WPA (Wi-Fi Protection Access) and WPA2 (Wi-Fi Protection Access 2)
encryption methods. When using the included WLAN USB stick under Windows,
an encrypted WLAN connection is set up automatically.

Configuration for experts!

Advanced settings for experienced users may be configured via the dsI* 1100
WLAN user interface once the dsI* 1100 WLAN has been connected to one or
more computers. The user interface can be accessed from any computer con-
nected to the dsI* 1100 WLAN.
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Virus scanner

The dsI™ 1100 WLAN is supplied with the Norman Virus Control software. Nor-
man Virus Control is an anti-virus program that monitors your PC for malicious
software, also referred to as malware:

The most common lypes of malware are viruses, worms, and trojans. For the
Sake of simplicity, we often use the term virus as a collective description.

@ Norman Virus Control can detect and remove known and unknown viruses
from hard disks, floppy disks, e-mail attachments, etc. Norman Virus Control
checks files when they are accessed, and possible viruses are removed auto-
matically. If Norman Virus Control is unable to clean an infected file, you will
receive a warning and instructions on how to proceed.
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2 Connection and installation

In this chapter, we will explain the displays and connections of the dsI* 1100
WLAN and show you how to set up the device. In addition, we describe the con-
nection of the computers via Ethernet and via WLAN using the included WLAN
USB stick. Networking examples are illustrated at the end of the chapter.

2.1 Display and connections

Power

Wireless Link/Act

DSL

Internet

Lit when it is switched on.

Lit when a WLAN connection to a computer or to another net-
work device exists; flashes during data transfers

DSL connection; flashes while setting up a connection; it
when a connection exists.

Lit when an active Internet connection exists.
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DSL
WECT

ETH1, ETHZ ETH3, ETH4

9vDC
0ff/0On
WLAN antenna

RJ11 socket for DSL cable to DSL port.

If this button is pressed, WECT restarts;

if this button is pressed for longer than five seconds, all of
the stored configuration data will be deleted and the router
will be restored to its factory defaults.

4 RJ45 sockets for network cable to connect computers,
dLAN adapters, IP telephones and/or other network devices

Connection to a power supply
Power switch

The WLAN antenna should be upright when in use.

The plate on the back of the device is removable.

Connecting the dsl* 1100 WLAN

Connecting one or more computers

Four computers can be connected directly to the four network ports of the dsI*
1100 WLAN. Additional devices may be connected via the WLAN access point
and the two networks — LAN and WLAN — bridged. All of the computers con-
nected to the dsI* 1100 WLAN are therefore linked in a single network and can
exchange shared files and use shared printers.
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2.2.1

Technical requirements

® dsl* 1100 WLAN
O To use your dsl* 1100 WLAN, you need a computer with an operating
system that provides network support with web browser (e.g. Windows
2000, Windows XP, Mac OS X, Linux) connected to the dsl* 1100
WLAN.
® \WLAN USB stick

O A computer running the Windows 2000 or Windows XP (32-bit) oper-
ating system is required when using the devolo WLAN USB stick and
automatic WLAN configuration (WECT).

Initial use
@ Remove the rear panel of the device.
(@ Move the WLAN antenna of the dsI* 1100 WLAN into an upright position.

® Use the included mains power adapter to connect the dsI* 1100 WLAN to a
power outlet.

@ Use the switch on the rear panel to turn the device on. The 'Power' LED will
light up on the front panel.

(® Use the DSL cable to connect the 'DSL' port of dsI* 1100 WLAN to your
Internet service provider's DSL line.
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® Plug the included WLAN USB stick into a USB port of your desktop or note-
book computer. Boot the connected computer. The 'WLAN' LED on the
router should now be lit.

For further information on installing the WLAN USB stick, please see ‘Installing
the WLAN USB stick in Windows'.

@ Use the included network cable to connect the 'ETH' port of your dsI* 1100
WLAN to the network port of your computer. Boot the connected computer.

To configure the WLAN and Internet access, continue in the following chap-
ter under 'Setting up the WLAN and Internet access with the configuration
wizard ",

Installing the WLAN USB stick in Windows

Use the WLAN USB stick to connect a desktop or notebook computer to the
WLAN. The WECT function of the dsI* 1100 WLAN automatically configures
WPA2-encrypted connections between the dsI* 1100 WLAN and computers
using the included WLAN USB stick and running Windows 2000 or Windows XP
(32-bit).

With the WECT function, you are selecting a special devolo WLAN configura-
tion that uses the best settings for a WLAN network with the dsI* 1100 WLAN
and the WLAN USB stick. To connect to other WLAN networks (e.g. hotspots),
configure your WLAN settings in Windows.

Windows XP lets you switch back and forth between configurations as neces-
sary. Click the devolo arch in the system tray in the bottom right-hand corner of
your display and select the appropriate configuration.

[dsi+ 1100 WLAN |)




Cm Connection and installation |

Please note that support for WLAN connections can only be guaranteed for the
A Windows 2000 and Windows XP operating systems.
2.3 Networking examples
(@ Connecting a notebook to the WLAN; Internet access via the dsI* 1100
WLAN

Notebook via WLAN using the WLA
USB stick o

((( ))) ggdt?/v]Pz/szbps (LL

dsI* 1100 WLAN

@ Connecting a computer and IP telephone via Ethernet and multiple note-
books via WLAN; Internet access via the dsI™ 1100 WLAN

(J dsi+ 1100 WLAN |
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Router configuration

This chapter describes the configuration of the WLAN and Internet access, as
well as covering the advanced functions and settings of your router with the
expert configuration.

For configuring the network and setting up Internet access, we recommend
using the setup wizard, which will help you configure the necessary settings
(‘Setting up the WLAN and Internet access with the configuration wizard ).

Alternatively, you may also set up Internet access using browser-based config-
uration (‘Setting up Internet access via a browser). The ds/* 17100 WLAN is
already optimally pre-configured for simple Internet access.

The additional functions of the router must be set up manually using the
browser-based configuration ("Expert configuration’).

Setting up the WLAN and Internet access with the
configuration wizard

Use the devolo configuration wizard if you are using a computer running a Win-
dows operating system to configure the router.

@ Insert the provided devolo product CD into the CD-ROM drive. The 'dsI*
1100 WLAN' setup software will start automatically.

If the software setup does not start automatically, please run ‘autorun.exe'in
the root folder of the CD.

(@ From the CD setup, select 'Install dsI* 1100 WLAN'.

® The wizard will now install the selected devolo software on your computer.
‘Start WLAN configuration' is active by default.

Windows may prompt you to restart your computer once the installation is com-
plete.

@ If you intend to set up your Internet access via WLAN, you must configure
the WLAN connection first. The WLAN configuration wizard will start and
will prompt you to press the WECT button on the dsI* 1100 WLAN. The
WLAN connection will then be configured automatically.
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3.2.1

(® Next, the router configuration wizard will start automatically. It will start by
checking the computer's network settings and adjusting them if necessary.
Once the network settings are correct, the wizard will assist you in setting
up Internet access for your router.

® Finally, the wizard will contact the website www.devolo.com to ensure that
the Internet access is working. If the Internet connection is working cor-
rectly, configure the other connected computers. Insert the devolo product
CD in the computers to be configured and run the ‘dsl* 1100 WLAN instal-
lation" as a minimum. The wizard will then check the settings of the network
and correct them as necessary, and will skip setting up Internet access again
if so requested.

Setting up Internet access via a browser

If you cannot use the configuration wizard (e.g. if you are not using Windows as
your operating system) you can carry out the settings via the user interface.

The computer which is networked with the dsf* 1100 WLAN must be set to auto-
matically acquire network information (DHCP). Further information regarding
the correct setting is available in the documentation of your operating system.

(@ Open your web browser and enter the URL 'http://192.168.0.253".
@ Click on the "Setup wizard" in order to configure your Internet access.
® Select your country and click on Next.

@ Select your Internet provider and click on Next.

(® Enter your access information provided by your Internet provider (username,
password). Confirm the password and click on Next.

(® Complete the setting up of your Internet access with Finish. Your input is
then saved.

Overview

The 'Enable WLAN' and 'Disable WLAN' buttons are located on the homepage.

Bk
" (e

disconnected
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3.2.2

Ifthe wireless network is disabled, all WLAN users will not be able to access your
dsf* 1100 WLAN.

Connection status

If you have successfully set up the Internet connection, the router can automat-
ically make a connection to the Internet on behalf of the computer in the net-
work.

dsl* 1100 WLAN 2OUVSC

Overview >
Connection status

DSL connection

Status of the DSL network connection. The DSL connection is used to establish the connection to the Internet. The
DSL connection can also be active even when there is no connection to the Internet provider

Status: disconnected
Downstream rate: -

Upstream rate: -
Fastpath: -

Internet connection
Status of the connection to the Internet provider.

Status: waiting for DSL connection
IP address: -

WLAN connection

Status of the wireless netwark.
S5ID: devolo-000B3B111111
Encryption: WPA or WPA2

WLAN stations

Here you can see the stations currently connected to the access paint.

@ 'DSL connection: Status of the DSL network connection. The DSL network
connection is used to establish the connection to the Internet. The DSL con-
nection can also be active even when there is no connection to the Internet
provider.

@ ‘Internet connection': Status of the Internet connection. The current IP
address allocated by the Internet provider can be found here.

® 'WLAN connection': status of the WLAN connection
O 'SSID": displays the name of the network.

O 'Encryption': states the type of encryption used.
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3.23 WLAN stations
"WLAN stations' lists the WLAN devices currently connected to your dsI* 1100
WLAN.
dsI* 1100 WLAN $00VI2
Overview > Connection status >
WLAN stations

Connected stations
Here you can see the stations currently connected to the access point

Mo stations are connected to the access point at present.

3.3 Expert configuration

In this chapter we will guide you through the expert configuration of the dsI*
1100 WLAN and explain its functions and settings.

(@ Open your browser and enter the URL 'http://192.168.0.253".
@ Select the link 'Expert configuration'.
® Select the link 'Change configuration'.
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Change configuration

Security

Under 'Security' you can enter a configuration password in order to limit access
to the router configuration.

LY r =N
dsI* 1100 WLAN £000392
Overview > Expert configuration > Change configuration »

Security
Password

Flease define a password to limit access to the device configuration

FPassword: eeesesssssseses

Repeat password. esssssssssssses

Universal Plug&Play (UPnP)

UPnP enables cerain applications to find and to configure the device automatically. This method of access is
availahle to all computers in the local network, Deactivate this option if you wish to prevent unauthorised persons
frorm making changes to the device configuration.

[ Allow access via UPnP

Select a password so that no unauthorised persons can change the configura-
tion. Confirm it in the ‘Repeat password' field. Should you ever forget your pass-
word, you will need to press the 'WECT' button (for longer than five seconds) on
the back of the router. However, this will also delete all of your configuration
data. You can read about how fo secure your configuration data under ‘Save
configuration file'.

@ 'Universal Plug&Play (UPnP)": If access via Universal Plug&Play is permitted,
the configuration of the router can be changed by any computer on the net-
work.

This function is deactivated as standard.

Network settings

This is where you enter the IP address under which the router is to be available.
The standard setting is '192.168.0.253". In addition enter the netmask (stan-
dard '255.255.255.0"). If you want to configure your dsI™ 1100 WLAN for an
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automatic IP address ('DHCP server), activate the function 'Automatically assign
network settings for computers in the local network'.

dsI* 1100 WLAN 290UV

Owerview > Expert configuration » Change configuration »
Network settings

IP address
Here you can configure the local IP address and netmask for the device.

IP address: | 192 168.0.253

Metmask: | 265, 255.265.0

DHCP server

Automatically assion network settings for computers in the local netwark

Connection establishment
Your router can maintain a continuous connection to the Internet, or establish a connection only when reguired

| have a flat rate, | want to be connected to the Internet at all times

@ ‘'Connection establishment': If you want to maintain a continuous connec-
tion to the Internet, active the function 'l have a flat rate, | want to be con-
nected to the Internet all the time".
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WLAN settings

"WLAN settings' contains all of the configuration options related to your wireless
network:

dsI* 1100 WLAN #0002

Overview > Expert configuration > Change configuration =

WLAN settings

Settings

Please selectthe settings to be used by your wireless network.

Activate WLAN

Channel:| 2 ||
SSID: | devolo-000B3B111111

[] Hide SSID

Security

You may encrypt the data traffic of your wireless network to prevent unauthorized access to your data
() Mo encryption
© WEP

Flease enter the WEP key as a hexadecimal number. Hexadecimal numbers can contain the digits 0-9 and the
letters A-F

Key length:

Key:

@ WPAIWPA2
Please enter the WPA key as a string of characters. Al letters and digits are valid characters

Key: [11111:11111:11111:99999

[ only permit WPAZ (maximum security)

® Settings
O 'Activate WLAN': enables and disables the wireless network.
O 'Channel": select the radio channel here.
O 'SSID": name of the wireless network
O The 'Hide SSID' function is one of several security features. With the
SSID hidden, only WLAN participants that know the name of your wire-
less network can connect to it.
® Security
O 'No encryption': your data communication is not encrypted.
O 'WEP": Wired Equivalent Privacy encryption applies a 64-bit or 128-bit
key, depending on your choice under 'Key length'. Define your hexadec-
imal key under 'Key'.

| devolo dsi+ 1100 WLAN |)




Cm Router configuration

O 'WPA/WPA2': Wi-Fi Protection Access and Wi-Fi Protection Access 2
encryption replace the static codes of WEP with dynamic keys for
enhanced security. Define your alphanumeric key under 'Key'.

O Select WPA2 for the best possible security (‘Only permit WPA2 (maxi-
mum security)")

® WLAN filters

O Specify the WLAN devices that are permitted to access your wireless

network here. Enter the MAC addresses of the appropriate devices.

dsl* 1100 WLAN $OVVIS2

Overview > Expert configuration > Change configuration >

WLAN filters

At present, any device can log onto your wireless network. To restrict access to the network, enter the MAC
addresses of the permitted devices.

Flease enterthe MAC address ofthe desired device to add itto the list

Add device

& Please note: if you do not specify any devices, all WLAN users that know your
network name (55/D) and the WEP key will be able to access your wireless net-
work. Entering devices here will ensure that only the listed devices have access.
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Port forwarding

Services offered within the local network e.g. Internet file sharing can also be
made publicly available in the Internet.

Wy
(W)

dsl* 1100 WLAN H@ U

Overview = Expert configuration > Change configuration > Port forwarding >
Add forwarding

Enter the IP address of the local computer that is praviding the service.
Local IP address: |

Selectone ofthe senvices as defined, or enter the port range for the service of your choice.

(&) Service

HTTP A
FTP

S5H

Telnet

MNetMeeting

WHNC

Remote Desktop Connection
poAnywhere >

> Portrange
Mame
First port

Last port

@ ‘local IP address": IP address of the local computer which makes its services
available.

@ ‘Service': Select the service here, e.g. eMule (Internet file sharing).

@ ‘'Portrange': Enter the port numbers of the desired service under 'Start port'
and 'End port".

Dynamic DNS

The Dynamic Domain Name System controls the allocation of dynamic IP
addresses to fixed computer names. The router registers your public IP address
as assigned by your Internet provider (IP addresses of this type are renewed
reqularly) with a provider of dynamic DNS, so that the services which you make
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public in the Internet are always accessible under the computer name of your
choice.

+ s =N
dsI* 1100 WLAN 20900032
Overview > Expert configuration > Change configuration >

Dynamic DNS

The router can automatically register vour public IP address with 3 dynamic DNS provider, which makes your
semvices publicly available in the Internet under the name of your choice

You will receive the access data if you register with one of the providers listed below.

[] Activate dynamic DNS

DDNS provider:

User name: |
FPasgward: |
Repeat password: |

Host name: |

‘Activate dynamic DNS': This is where you activate the DDNS function.
'DDNS provider': Select the DDNS provider here.

‘User name": This is where you enter the user name given to you by your
DDNS provider.

'Password": This is where you enter the password given to you by your DDNS
provider.

'Repeat password': This is where you confirm the password given to you by
your DDNS provider.

‘Host name': Enter a fixed computer name here (e.g.
www.example.dyndns.org).

Reset configuration

Here you can reset all of the settings of your dsI* 1100 WLAN.

-
(¥
()

dsl* 1100 WLAN @ Q) (

Overview = Expert configuration =
Reset configuration

Reset configuration

Ifyou continue, all settings in the device will be delsted and resetto their factory default values. Al of the settings you
have made will be lost.

Reset configuration
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@ 'Reset configuration': Here you can reset the configuration of the router to

its factory settings.
A Please note that all of your previous configuration settings will be lost.
3.3.2 Save configuration file

You can store the configuration of the router in a file on your computer or
another data medium.

O
()

dsl* 1100 WLAN OO0V

Overview » Expert configuration >
Save configuration file

Save configuration file
You can store the configuration of the device in a file on your computer and restore it later when reqguired.

[ saveconigurationfile |

333 Restore configuration file

If you have unintentionally changed the configuration, you can transfer the set-
tings in a previously saved configuration file to the router by selecting it and
clicking on Restore configuration file.

O

dsI* 1100 WLAN $00US

Overview > Expert configuration >
Restore configuration file

Restore configuration file
Enter the path to and the name of the configuration file. You can also browse for the file in any directory

File name: | |[ Browse..

[ Restore configuration file ]

334 Update firmware

The firmware controls the internal programs of the router. This may be updated
occasionally. Download the current firmware from the devolo homepage at
www.devolo.com. Then proceed as follows:

@ Scan the appropriate directory and select the downloaded firmware file.
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@ Then click on Update firmware in order to transfer the new firmware on
to the router.

dsI* 1100 WLAN L VT =)

Overview > Expert configuration »
Update firmware

Current firmware version: 1 (06/26/2006)

Update firmware
Enter the path to and the name of the firmware file. You can also browse for the file in any directory.

File name: | Browse..,
Update firmware

If you have any questions regarding terminology and scenarios please read the
information at www.devolo.com.

=0
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4.2

devolo software

This chapter introduces you to the Informer, Extended Port Forwarding, Easy-
Share and EasyClean software. Furthermore, it describes how to install them.

Overview of the devolo software

devolo Informer

The Informer shows you information about your dsI* 1100 WLAN, such as the
IP address assigned by your Internet provider as well as current DSL connection
data.

devolo Extended Port Forwarding

With Extended Port Forwarding you can make the services offered on your
cmputer publicly available on the Internet.

devolo EasyShare

EasyShare is a file-sharing and chat tool for your local network. It allows you to
exchange files easily between local Windows computers. The chat function
allows instant communication between all network users.

devolo EasyClean

Microsoft Internet Explorer stores files in a cache on your hard drive while you
surf the Internet. With EasyClean, you can determine which of these unwanted
files you would like to delete.

Installing the devolo software

The devolo software is normally installed together with the installation wizard.
To install the devolo software separately on a computer with a Windows oper-
ating system, follow the steps below.

@ Put the enclosed devolo product CD in your CD-ROM drive.

(@ From the CD setup, select 'Install dsI* 1100 WLAN'. Windows starts the wiz-
ard. Confirm by clicking Next.
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4.3

If you would like to install the complete devolo software package, select 'Stan-
dard Installation”. Then, click Next.

® Select 'Custom Installation' to choose the software components you would
like to be installed yourself. Then, click Next.

@ Terminate the installation by clicking Finish.

(® After the installation has been completed successfully, start the devolo tools
by clicking Start > Programs »> devolo > EasyClean, EasyShare,
Extended Port Forwarding, Informer or WLAN configuration wiz-
ard.

Overview in the network with the devolo
Informer

Due to the Informer you always have an overview of your dsI* 1100 WLAN.

®_ devolo Informer

Device Wiew Help
&3 dsh+ 1100 WLAN
§ Firmware version: 1 {6/26/2006)

Status: connecked

Public IP address: 172.159.209.147
-& Upstream rate: 448 Kbps
\'} Downstream rake: 3456 Kbps

The Informer shows you information about the connection status, the IP address
assigned by your Internet provider as well as current DSL connection data.

To open the user interface of the router, highlight the router and select Device
» Open Status and Management from the menu, or Open Status and
Management from the conext menu.
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4.4
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Port forwarding with

devolo Extended Port Forwarding

With Extended Port Forwarding you can make the services offered on your com-
puter publicly available on the Internet. If your desired application is pre-con-
figured in the list, simply click on the checkbox and then activate port forwarding

by confirming with OK.

& devolo Extended Port Forwarding @

‘fou can select applications from the list below that are to be made visible in the Internet, Click.
on the respective box of the application to activate the port forwarding.

ImE=1]
HE=lar]

& ==H

[ & Telnet

|:| @ MetMeeting
] VEunc

|:| %Remote Desktop Connection
| @pcnnywhere
O @eMule

O '_@_'lGnuteIIa

[ mKazaa

If the application is not listed above, you can enter it here.

Add application. ..

[ o

][ Cancel ]

@ 'Add application': If your desired application is not in the list, add your new
entry by clicking Add application. Specify the port numbers or ranges,
enter a description of your application and confirm with OK. The new appli-
cation will be added to the list. Activate port fowarding by clicking on OK.

@ ‘'Remove application: If you would like to delete an application from the list,

select it and click on Remove application.

Only those entries that you have added can be deleted.
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4.5

4.5.1

Communication in the network using
devolo EasyShare

All users on the local network who have started EasyShare are automatically rec-
ognized by the program and listed:

'L devolo CasyShare
B Ik Hop

=M

ol it radaasad, It coud b .';."'m . - HeiE
Adrdstasheet_devoks dan_duo_en.pdf Finished  Marketing

|_sen £ ¥

Configuration

The EasyShare software provides two easy wizards, which will guide you quickly
and easily through the configuration process: the first setup wizard, which starts
automatically the first time the program is started, and the sharing wizard,
which allows you to add shared items at any time. The individual functions of
the EasyShare software are described here:

Folder sharing

To share data with others, a EasyShare network user has to make the data avail-
able in a shared folder. When a folder is shared, all of its files as well as the files
of all its subdirectories become available to all users on the EasyShare network.
Folders can be shared either by using the initial setup wizard, which opens auto-
matically the first time the EasyShare is started, or by using the sharing wizard.
You can open the sharing wizard by clicking the Add share button, or by select-
ing File > Add share from the menu.
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Options

Every computer has a name. When EasyShare is first installed, you can assign a
new name to your computer or use the default name suggested by the operating
system. Your computer is visible by this name to all EasyShare users.

The computer name can be changed at any time by clicking the Options button
or by selecting Tools » Options from the menu.

Refreshing shared folders

To view (newly) shared folders of other EasyShare network users, select File »
Refresh from the menu, or Refresh from the context menu (right mouse but-
ton). The contents of all shared folders will appear in the top right-hand win-
dow.

Downloading files

To download shared files from other EasyShare network users, select the com-
puter belonging to the user and then mark the shared folder for that user. The
upper-right window then lists all the contents of the folder. From the list, mark
the files and/or folders that you want to download and then select File b
Download from the menu, or Download from the context menu (right mouse
button). Choose a target folder on your computer and confirm by clicking OK.
The files are now downloaded to your computer. The status of the download is
displayed in the lower-right window entitled 'Data transfer in process'.

Data transfer in process

All 'Data transfer in process' are displayed in the lower right window and disap-

pear from the screen once they are finished.

@ The 'Name' column indicates the name of the file being downloaded.

@ The 'Status' column shows the current transfer progress and the transfer
speed.

@ The 'Host' column shows the computer from which the file is being down-
loaded, or to which it is being uploaded from your computer.

You can cancel the current download by clicking the file and selecting Cancel
from the context menu (right mouse button).
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Chatting

The lower left window functions as a chat room, which is visible and accessible
to all EasyShare users on the local network. Users can "chat" by writing mes-
sages and clicking Send.

4.6 Maintain your privacy with devolo EasyClean

With EasyClean, you can delete the cached files listed below. Select the check-
boxes of the file types you would like to remove, then click Delete.

# devolo EasyClean @

Please select the data for deletion.

Internet Explorer

Cookies are small files that can be used to store the settings for web sites, e.qg.
ordered goods,

Delete temporary Internet files

Internet Explorer stores the files from web sites to accelerate the display of the
pages.

Delete hiskory

Every web site that you visited in the last bwo to three weeks is stored in the
History Folder,

Delete stored Form data

The Internet Explorer provides the option of filing in your entries automatically,
Ta da this, it remembers the data that you type in.

Delete stored passwords
The Internet Explorer provides the option of filing in your access data
automatically.

File: lists
[ :‘ Delete the list of recent files
Warious lists of the files recently opened or websites recently visited are saved

on the computer, These include the address list in the Internet Explorer and the
list of recently run programs,

[ Delete ] [ Close ]

® Cookies—Many websites store small files on your computer, so-called
cookies. These files may contain personal information such as log-in data,
passwords or credit card numbers.

® Temporary Internet files—Temporary files are stored on your hard drive
while you surf the Net. Over time, these files take up a considerable amount
of space.
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History files—Internet Explorer records your surfing activity over a period
of days or weeks. This can be practical, but it also takes up space and can
be undesirable in many cases.

Stored form information—Internet Explorer stores information that you
enter in forms and can auto-complete this information in the future.

Stored passwords—Passwords can also be stored and automatically
inserted together with usernames in subsequent log-in procedures. While
this is convenient, it's also dangerous—especially in connection with bank
transactions. Sensitive information such as this should only be stored locally
in special programs designed for this purpose.

Document history—Internet Explorer maintains lists of open documents
and visited websites. This information is generally no longer needed.

Please note that FasyClean only supports Microsoft Internet Explorer.
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5 Appendix

5.1 Performance data and specifications
dsI* 1100 WLAN
LAN standards Ethernet specification IEEE 802.3

Fast-Ethernet specification IEE 802.3u
Fullduplex specification IEEE 802.3x
Auto MDI/MDIX

WLAN IEEE 802.11b/g(g++)

DSL standard ADSL over ISDN (Annex B [Germany])

T-Com Spezifikation 1TR112 (U-R2)
ITU G.992.1 (G.dmt)

ITU G.992.3 (ADSL2)

ITU G.992.5 (ADSL2+)

ITU G.994.1 (G.hs)

oder: ADSL over POTS (Annex A)
ANSIT1.413 Issue 2
ITU G.992.1 (G.dmt)
ITU G.992.2 (G.lite)
ITU G.992.3 (ADSL2)
ITU G.992.3 Annex L (RE-ADSL2)
ITU G.992.5 (ADSL2+)
ITU G.994.1 (G.hs)
ITU G.997.1 (G.ploam)

Transfer rates ADSL:  up to 25 Mbps
Wireless: up to 54 Mbps (IEEE 802.11g standard),
up to 125 Mbps (g++ turbo mode, proprietary)

Wireless frequency range | 2412 MHz — 2472 MHz

Firewall Stateful Packet Inspection
Stealth Mode
DoS-Blocking
NAT
IP Masquerading
Wireless encryption WEP
WPA
WPA2
Ports 4 Ethernet LAN with Auto MDI/MDI-X
1 WLAN access point
1 ADSL WAN
WAN port Connection type: RJ11 (DSL)
LAN ports Connection type: RJ45 (Ethernet)
WLAN port Coaxial connector for removable, articulated 2.4 GHz antenna
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dsl* 1100 WLAN

LEDs

Power supply
Ambient conditions

Protocols

System requirements

Miscellaneous

CE conformity

Warranty

Internet status
Power

DSL status
WLAN status

Power adapter 9V DC, 1000mA, EU
0-40°C, 10-90% humidity (non-condensing)

TCP/IP

ubpP

DHCP server
Dynamic DNS
UPnP

PPPoE

PPPoA

VPN Pass Through
ATM AALS

CD-ROM drive
Computer interface: wired: Ethernet (RJ45)

wireless: USB or 802.11b/g WLAN client
One of the following operating systems:
dsl+ 1100 WLAN: Windows 2000, Windows XP. Mac OS X, Linux
WLAN USB stick: Windows 2000, Windows XP (32- bit)
Internet access: DSL line

Firmware updates in file

Internet provider selection from a list for automatic DSL configura-
tion

Automatic setup of encrypted WLAN connection (WECT)

Initial access also possible directly via WLAN interface

Backup and restore configuration data

Port forwarding/virtual server

Quality of Service (QoS)

On/off switch

WECT button — for automatic configuration of a WPA2-
encrypted 802.11g++ (125 Mbps) wireless connection between

the WLAN USB stick and dsI* 1100 WLAN

CE conformity in accordance with the technical requirements for
all EU countries and Switzerland

EN 60950x

EN 55022x

EN 55024x

3 years
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5.2

Declaration of conformity

C€

KONFORMITATSERKLARUNG

EC DECLARATION OF CONFORMITY

Die Firma: devolo AG
The Company: Sonnenweg 11
52070 Aachen

erklart, dass das Produkt: ~ dsI* 1100 WLAN
declares that the product:

Verwendungszweck: ADSL2+ WLAN Router mit WLAN USB Adapter
Intended purpose: ADSL2+ WLAN Router with WLAN USB Stick

den grundlegenden Anforderungen des § 3 und den Ubrigen einschlégigen Bestimmungen
des FTEG (Artikel 3 der R&TTE) entspricht.
complies with the appropriate essential requirements of the FTEG (Article 3 of R&TTE) and the other relevant
provisions.

Dieses Wireless-Gerét ist ein Sender bzw. Empféanger. Bei der Installation und Verwendung
dieses Gerétes sollte ein Abstand von mindestens 20 cm zwischen dem Gerét und Ihrem
Korper eingehalten werden.

This wireless device transmits and receives radio signals. During the installation and utilisation of this device,
please ensure that there is a distance of at least 20 cm between the device and your body.

Harmonisierte Normen: Gesundheit und Sicherheit gemaB §3 (1) 1. (Artikel 3 (1) a))
Harmonised standards: Health and safety requirements contained in §3 (1) 1. (Article 3 (1) a))

EN 60950-1:2001

Harmonisierte Normen: Schutzanforderungen in Bezug auf die EMV §3 (1) 2, (Artikel 3
(1) b)
Harmonised standards: Protection requirements with respect to EMC §3 (1) 2, (Article 3 (1) b)

EN 55024:1998+A1:2001+A2:2003
EN 55022:1998+A1:2000+A2:2003
EN 301 489-17 V 1.2.1 (2002-08)
EN 301 489-1 V 1.4.1 (2002-08)
EN 300 328 V 1.6.1 (2004-11)

Diese Erklarung wird verantwortlich abgegeben durch:

This declaration is submitted by:
Aachen, 7. August 2006 /
Aachen, 7" August 2006 Heiko Harbers

Vorstandsvorsitzender
CEO
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5.3

C€

54

CE conformity

The product conforms to the basic requirements of Directive 1999/5/EC (RGTTE)
and the other relevant provisions of the FTEG (Radio and Telecommunications
Terminal Equipment Act), and is designed for use in the EU and Switzerland.

This product is class A equipment. This equipment may cause interference with
radio waves in home use; if this occurs the operator may be required to take cor-
rective action.

Care and maintenance of the device

There are no user-serviceable parts inside the case. Do not open the case. Clean
the unit by wiping dirt from the case using an eyeglasses cleaning cloth or other
soft cloth. Never use water, paint thinner, benzene, alcohol or other strong
cleaning agents when cleaning the dsI* 1100 WLAN, as these could damage the
case.
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5.5 Warranty conditions

The devolo AG warranty is given to purchasers of devolo products in addition to the warranty con-
ditions provided by law and in accordance with the following conditions:

1 Warranty coverage

a) The warranty covers the equipment delivered and all its parts. Parts will, at devolo's sole dis-
cretion, be replaced or repaired free of charge if, despite proven proper handling and adher-
ence to the operating instructions, these parts became defective due to fabrication and/or
material defects. Alternatively, devolo reserves the right to replace the defective product with
a comparable product with the same specifications and features. Operating manuals and any
supplied software are excluded from the warranty.

b)  Material and service charges shall be covered by devolo, but not shipping and handling costs
involved in transport from the buyer to the service station and/or to devolo.

) Replaced parts become property of devolo.

d) devolo is authorized to carry out technical changes (e.qg. firmware updates) beyond repair and
replacement of defective parts in order to bring the equipment up to the current technical state.
This does not result in any additional charge for the customer. A legal claim to this service does
not exist.

2 Warranty period

The warranty period for this devolo product is three years. This period begins at the day of delivery
from the devolo dealer. Warranty services rendered by devolo do not result in an extension of the
warranty period nor do they initiate a new warranty period. The warranty period for installed
replacement parts ends with the warranty period of the device as a whole.

3 Warranty procedure
a) If defects appear during the warranty period, the warranty claims must be made immediately,
at the latest within a period of 7 days.

b) In the case of any externally visible damage arising from transport (e.g. damage to the case),
the person responsible for the transportation and the sender should be informed immediately.
On discovery of damage which is not externally visible, the transport company and devolo are
to be immediately informed in writing, at the latest within 3 days of delivery.

¢) Transport to and from the location where the warranty claim is accepted and/or the repaired
device is exchanged, is at the purchaser's own risk and cost.

d) Warranty claims are only valid if a copy of the original purchase receipt is returned with the
device. devolo reserves the right to require the submission of the original purchase receipt.

4  Suspension of the warranty
All warranty claims will be deemed invalid
a) the label with the serial number has been removed from the device,

b)  the device is damaged or destroyed as a result of acts of nature or by environmental influences
(moisture, electric shock, dust, etc.),

) the device was stored or operated under conditions not in compliance with the technical spec-
ifications,

d) the damage occurred due to incorrect handling, especially due to non-observance of the sys-
tem description and the operating instructions,

e) the device was opened, repaired or modified by persons not authorized by devolo,

f)  the device shows any kind of mechanical damage,
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g) the warranty claim has not been reported in accordance with 3a) or 3b).

5 Operating mistakes

If it becomes apparent that the reported malfunction of the device has been caused by unsuitable
software, hardware, installation or operation, devolo reserves the right to charge the purchaser for
the resulting testing costs.

6 Additional regulations

a) The above conditions define the complete scope of devolo’s legal liability.

b)  The warranty gives no entitlement to additional claims, such as any refund in full or in part.
Compensation claims, regardless of the legal basis, are excluded. This does not apply if e.g.
injury to persons or damage to private property are specifically covered by the product liability
law, or in cases of intentional act or culpable negligence.

¢)  Claims for compensation of lost profits, indirect or consequential detriments, are excluded.

d) devolo is not liable for lost data or retrieval of lost data in cases of slight and ordinary negli-
gence.

e) In the case that the intentional or culpable negligence of devolo employees has caused a loss
of data, devolo will be liable for those costs typical to the recovery of data where periodic secu-
rity data back-ups have been made.

f)  The warranty is valid only for the first purchaser and is not transferable.

g) The court of jurisdiction is located in Aachen, Germany in the case that the purchaser is a mer-
chant. If the purchaser does not have a court of jurisdiction in the Federal Republic of Germany
or if he moves his domicile out of Germany after conclusion of the contract, devolo’s court of
jurisdiction applies. This is also applicable if the purchaser's domicile is not known at the time
of institution of proceedings.

h)  The law of the Federal Republic of Germany is applicable. The UN commercial law does not
apply to dealings between devolo and the purchaser.
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